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Getting Started

Installing SQ Designer (“SQD”)
Before installing SQ Designer you must first install the Adobe Air runtime environment. This is 
available free for Windows and Mac OS X. You will need version 1.5 of Air or better. 

Install SQ Designer by downloading the .zip file from the Square Connect website, unzip to a 
location of your choice, then simply double click the .air file and follow the on-screen instructions.

Loading and Saving Configuration Files
SQD understands the .zip files that SQ Remote stores and retrieves from box.net. You should not  
unzip these files as SQD will handle all the zipping and unzipping.

It is recommended that you start working from a configuration that you have saved to box.net from 
SQ Remote, as this will then include all your device files and information about your blaster 
systems. 

Simply download the box.net file that you want to edit (using the load from box.net options from 
within SQD). SQD will load and work with local copies of the files from the selected configuration 
zip file that you select, and will update the zip file on a save command.

It is a good idea to keep backup copies of your configurations (you can export your configurations 
to your local file system). Its also a good idea to use the auto-save option (See Preferences), as no 
software is infallible, and the unforeseen may happen. 

If you load an old configuration that is missing certain configuration files, SQD will create these for 
you. In certain cases, essential files might be missing if you try to load a VERY old file from a much 
earlier version of SQ Remote. SQD will then abort the configuration process. Please contact us if 
you have any difficulties in this regard. We do not expect there to be any issues as this will only 
occur with configuration files from the very early versions of SQ Remote.

Using SQ Designer 
SQ Designer (or SQD) has been created with the same paradigm as the SQ Remote app. It will be 
easier to use this software for creation and development of control configurations if the user has 
this in mind, particularly when creating a new configurations from scratch. 

Step 1: Add SQ Blasters to the configuration. Even if these are “pseudo blasters” they will enable 
you to add devices and assign commands ready to be moved to a real blaster later.
Step 2: Add devices (ir command sets) to the blasters
Step 3: Create the control pads and Panels
Step 4: Assign your controls to commands
If you start editing an existing configuration then most of these steps will have been done for you 
automatically.
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SQ Designer Functionality

The Main Editing Screen
This screen is displayed at start up and is the main editing area for your controls. SQD has been 
written to incorporate many of the common editing options that  you will find in most graphic 
drawing packages - so that most editing tasks can be achieved quickly and easily.

SQ Designer main editing screen showing iPad editing and classic theme

SQ Designer can be used to edit iPhone style layouts as well as iPad layouts. Although SQ 
Remote HD allows compatibility between iPad and iPhone screen sizes, SQ Designer makes it 
simple to edit and customize control panels. So its quite simple to create a set of controls for the 
iPad (for example) and then cut and paste these into additional control panels for iPhone use.

You can switch between iPhone and iPad modes using the Device selection tool in the editing tool 
bar section above the main edit area.
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Control Pads & Panels
On the right hand side of the main screen there is the control pads and 
panels “tree”. Selecting a pad or a panel within this area will cause the 
selected item to be displayed in the main display area of SQD ready for 
editing.

Clicking on the hide/show arrows will expand and contract the display of 
control panels for each control pad.

Changing the order of Control Pads
Control pad order can be changed by dragging and dropping the control 
pads within this tree.

Changing the order of Control Panels within a Control Pad
Control Panels can be dragged and dropped within a control pad to re-
order them. Control panels cannot be dragged between control pads. If you wish to move or copy a 
control panel to another pad, simply copy and paste the entire contents of one panel to another. 

Note that the control panels (within a control pad) shown are shown in the following order on the 
iPhone, iPod Touch and iPad (in 2x mode)

1) Main - this is the control panel area that is shown when a control panel is opened.
2) Top Left (Slide in Panel)
3) Middle Left (Slide in Panel) 
4) Bottom Left (Slide in Panel)
5) Top Right (Slide in Panel)
6) Middle Right (Slide in Panel)
7) Bottom Right (Slide in Panel)

Renaming the “Main” control panel has no visible effect on the iPhone as this panel has no visible 
name tag. However this name is shown on the iPad in the navigation buttons at the bottom of the 
screen.

The Setup Control Pad
This cannot be edited within the editor. It is not recommended that user attempt to edit this from 
within the xml documents directly as this is a key element, that if changed or missing may cause 
SQ Remote to crash.

Control Pad PopUp Menu
Right clicking on a ‘selected’ control pad in the Control Pads 
and Panels section will bring up the popUp menu as shown 
here. Make sure that the control pad is ‘selected’ first with a left 
mouse click,  as a right click will not ‘select’ a control pad or a 
control panel.  This menu will only appear if a control panel is 
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selected.

The options are:

- Add a New Control Pad: creates a new control pad in the current configuration and adds it to the 
bottom of the tree.

- Copy Control Pad: creates a copy of the currently selected control pad and adds it to the current 
configuration and adds it to the bottom of the tree. (Note to copy a control pad to another 
configuration, you will need to create a template. See below).

- Create New Control Pad Template: creates a template from the currently selected control pad.  
(includes all the control panels within the current control pad.) See the section on Templates later 
in this user guide.

- Delete Control Pad: deletes the currently selected control pad. Note that this is irreversible!

Control Panel PopUp Menu
Right clicking on a ‘selected’  control panel within the tree will bring up a popUp menu with one 
option that allows you to create a New Template for the selected control panel (This is the panel 
that is on display in the middle of the editing area). If a control panel is not selected then this menu 
will not appear.

Editing a Control Pad
Control pads can be edited in the following way:

- Image: drag a new image from the “Carousel Images” area from the right hand side of SQD into 
the control pad area. 

- Title and 2nd Line - simply edit the text in the 2 text fields presented at the bottom of the screen

SQ Designer - User Guide v1.5 

Page 6 of 37



Note: SQ Designer does not support adding new images for the carousel at this time.

Editing a Control Panel
This is the main editing area of SQD.

Control Panel Name
SImply edit the name in the text field at the 
bottom of the screen. remember that the 
control tabs in SQ Remote do not allow long 
titles, so it is recommended that you keep 
your panel names short!

Device Type Selection
The size of the control pad area can be chosen depending on the target 
device. This feature is still under development and will tie together with 
the release of additional applications for these platforms. A universal 
application that runs as a native app on the iPad is currently under development. 

Adding Controls to Control Panels
Simply drag the required control types from the control element area on the right hand side of the 
screen and drop it into place on the “open” control panel. 

- Standard Buttons: These are standard IR type button controls that can 
be linked to any IR command or to a macro. Find the size / shape that 
you want and drag it to where you need it.

- Standard Icons: Drag these into the buttons on the control pad to give 
them icons. Alternatively you can add icons in the Button Editing Screen 
(see below):

- Other Controls: This is where you will find the other standard control 
elements such as:

- Labels

- Grouped Circle Controls

- Standard List Controls

- Standard WebViews

- Home Automation Controls (MiOS)
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Editing Controls within the Control Pad Area
SQD offers many of the standard controls for manipulating images within a canvas that you will find 
in most graphic packages:

Select: To select any one control, simply left click on it. It will then shown a faint selected rectangle.

Multi-Select: To select more than one control, hold down the shift (or command OSX) key and 
click on additional controls. 

Selection Box: To select more than one control with the mouse, click and drag a rectangle around 
(or across) any controls to select them. Any control that is within (or bisected by) this selection 
rectangle when the mouse button is released will remain selected.

Select All: By selecting “Select All” from the Edit menu, or by pressing ⌘+A  or (Ctrl+A Win/Lin) all 
the items on the control panel will be selected.

Deselect All: By selecting “Deselect All” from the Edit menu, or by pressing ⌘+D or (Ctrl+A Win/
Lin) any selected items on the control panel will be de-selected.

Move controls: Click within a selected control and drag it to where it is wanted. If there are more 
than one control selected, then they will be moved as a group.

Nudge controls: Selected controls can be ‘nudged’ by pressing the arrow keys (up/down/left/
right). Holding the arrow keys down will cause the selected items to be moved more rapidly. Single 
taps to the arrow keys will cause selected items to move by 1 pixel.

Copy: To copy a control (or selection of controls), select “Copy” from the Edit menu, or press ⌘+C 
(Ctrl +C Win/Lin). Copied controls can be pasted onto the same control panel or other control 
panels. The complete configuration of each control is copied.

Paste: Select “Paste” from the Edit menu, or ⌘+V (Ctrl +V Win/Lin) to paste copied items to the 
current (displayed) control panel. Copied objects will be pasted with a slight off-set from their 
original position, or centered around the last mouse click on the screen.

Cut: Select “Cut” from the Edit menu, or ⌘+X  (Ctrl +X Win/Lin) to paste copied items to the 
current (displayed) control panel. Copied objects will be pasted with a slight off-set from their 
original position, or centered around the last mouse click on the screen.

Delete: Select the items to delete, then press the Delete or DEL key.

Undo: While in the same control panel, you can undo up to 100 edit steps. To undo an edit press 
⌘+Z  (Ctrl +Z Win/Lin). Note that if you leave a control panel to move to another, the control panel 
is saved, and all ‘undo’ information is lost.

Snap to grid: The user can opt to set a specific grid size and to turn ‘snap to grid’ on to line up 
controls more easily. The user can change the grid size for either the x, or y direction, and elect to 
snap to the x, y grid lines or both. Note that this snap occurs after the mouse is released on a 
control. The grid controls are between the the main editing area and the tab selection at the top of 
the screen
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Align/Arrange controls: 12 alignment 
buttons are provided for rapid and 
accurate layout control. There are also 
two additional buttons that allow you to 
manipulate the z-order of the 

Bring to Front: The selected controls will be brought to the front (so that they will be in front of 
other controls. This is useful in arranging controls if they overlap.

Send To Back: The selected controls are sent to the back so that 
overlapping controls will be seen in front.

Align Left: The selected controls will be aligned on the screen 
with the left hand side of the control that is furthest to the left 
within the selected group.

Align Right: The selected controls will be aligned on the screen 
with the right hand side of the control that is furthest to the right 
within the selected group.

Align Top: The selected controls will be aligned on the screen 
with the top edge of the control that is highest within the selected 
group.

Align Bottom: The selected controls will be aligned on the 
screen with the lower edge of the control that is lowest within the 
selected group.

Align Center Vertical: The selected controls will be aligned about their vertical centers. Their 
position after centering will be at the vertical center of the selected group.

Align Center Horizontal: The selected controls will be aligned about their horizontal centers. Their 
position after centering will be at the horizontal center of the selected group.

Distribute Evenly Vertical: The selected controls will be distributed evenly between the two 
controls that are the highest and lowest within the selection.

Distribute Evenly Horizontal: The selected controls will be distributed evenly between the two 
controls that are the furthest to the left and right within the selection.

Stack Vertically: The selected controls will be distributed automatically in a vertical stack on the 
screen with zero pixels between them.

Stack Horizontally: The selected controls will be distributed automatically in a horizontal row on 
the screen with zero pixels between them.
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Button Control Editing
To edit a button within a control panel, select it then right click on it. This will open the button 
editing screen: You can also open the edit screen by double clicking on a control.

Change Button Size/Shape: To change 
the button type, drag a new button 
image into the preview screen.

Change Icon: To change the icon, drag 
a new icon into the preview screen.

Remove Icon: Click the Remove Icon 
button. 

Add / Change Text: Enter text into the 
text field.

Command Type Selection: Change the 
type of command with the radio 
selection buttons (Infrared Command or 
Macro).

IR Command Selection: If this is 
selected, then the assigned command can 
be selected by selecting the device from the drop down box: Select Device, then select the 
command from the list. You can search for commands in this list by typing your search text in the 
text box above the list of commands.  Note that the devices and commands that are displayed here 
are those that are available within the current configuration that is being edited. To add new 
devices these will need to be added to the configuration (See the section on managing AV devices)

Macro Command Selection: If Macro is selected, then a macro can be selected from the drop 
down box of macros that are available within the current configuration. You can create new macros 
and edit existing ones (as well as test them) in the macro section of SQD. Note: You must create 
macros within the current configuration before you can assign them to buttons. 

To discard your changes, press cancel, or to keep any changes that you have made, press the 
update button. This will take you back to the control panel for further editing.

Button Control Assignment Review
At the top of the editing area there is the option to show control 
assignment (as within the SQ Remote iPhone 
app). 

When this is selected any control that has an 
assignment to an IR Command or a Macro will 
show a green assignment icon. Unassigned 
controls will show a grey assignment icon.

This is to allow rapid localization of controls that 
are not yet assigned.
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Note that this feature has only been enabled for IR and Macro commands and is only present on 
Button controls.

Testing Button Controls
A further option that has been provided to make editing and setup as 
useful as possible is the ability to test buttons (send IR commands) 
directly from within the editor.

When this is selected, then all editing options on the control panels are suspended, and the 
buttons act as ‘buttons” , clicking on the buttons will cause SQD to send IR blast commands to the 
blaster that the commands are assigned to.

The commands that are sent 
to the blaster are shown in 
the console area at the 
bottom of the editing screen.

Note that this ‘in-situ’ testing is limited to IR commands only.

Label Control Editing
To edit a label within a control panel, select it then 
right click on it. This will open the label editing 
screen: 

Change Text: Simply edit the text in the text entry 
area.

Text Size: Change the size of the text in the “Size” 
box.

Bounding Box: If you change the size of the text, 
you may need to change the bounding box to prevent clipping of the text.

Text-Color: Click on the color selector and select a new color for the text.

Alignment: The alignment of the text within the bounding box can be selected using the 3 
alignment buttons.

List Control Editing 
To edit a list control, select it on the control pad and 
then right click on the control. This will open the 
editing screen for the selected list control.

List Selection: Select the list that the control should 
display (within SQ Remote), and the device that 
should be used for channel control. Note that you 
must select both list and device, even if there are no 
channels defined within the list control.
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Lists can be added and edited within the Command List area of SQD. You can also create a library  
of lists of your favorite channels that can be quickly added if you are configuring multiple systems. 
Lists can be exported and exchanged with other users.

WebView Control Editing
To edit a WebView control, select it on the control 
pad and then right click on the control. This will open 
the editing screen for the selected web view control.

You can then select the URL for the web view from 
the drop down list. Note that only those URLS that 
are defined within the configuration will be displayed 
here.

URLs can be added to the configuration in the URL 
section of SQD. You can also create a library of your 
favorite URLs that can be quickly added if you are 
configuring multiple systems.

Editing of Home Automation Controls
To edit a home automation control, select it on the 
control pad and then right click on the control. This 
will open the editing screen for the selected control.

You can then assign the selected control to a MiOS1 
system, and then a device or scene within the 
selected system.

In order to edit the assignment of home automation 
controls you first need to connect to your MiOS 
systems from within SQ Designer. 

See the section entitled Connecting to MiOS System later in this user guide.

 

Reviewing the control XML
This is an advanced feature intended for technical support, but you can 
also use it to inspect (and take a peek at) whats going on under the hood. 
When the  “Show Control XML” option is selected, a small display window 
appears at the bottom of the screen to display the underlying XML of any selected control. 
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An explanation of the XML used for individual controls within SQ Remote is beyond the scope of 
this user manual, but access to this information can be exceedingly useful if you need to contact 
Square Connect for support reasons.

The contents of this XML window are updated when a control is selected with a single click. The 
contents are not cleared or updated by clicks elsewhere in the control panel. Make sure that the 
xml  in the window is the correct xml code for the control that you are interested in by clicking on 
the required control before viewing the xml.

To copy the xml from this window you will need to use the mouse. Right click anywhere in the xml 
window and select: “Select All”. Then right click a second time and select “Copy”. The contents of 
the window have now been copied to the clipboard and can be pasted to any other application.

Expand the XML Window
You can expand this XML area by clicking on the small 
“drag” icon above the XML area. Click, hold and drag 
up or down to expand this area.
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Working With Templates
SQD has been designed to allow the user to create templates out of control pads and panels for 
reuse within the same configuration or to allow the rapid creation of new configurations using your 
own trusted layouts and preferences. SQ Designer does not come with predefined templates.

Control Panel Templates
SQD allows the user to create templates from the current “selected” (displayed) control panel.  

Creating new Control Panel Templates
To create a new template, either select “Create Control Panel Template” from the “Template” menu 
at the top of the screen, or left click on the selected template name in the Pads and Panels Tree 
on the left hand side of the editing screen.

You will then be requested to enter a name for this new 
template:

After entering a new name for the template, press the 
“Accept” button and a new template will be added to the 
Control Panel area, complete with a “screen shot” of the 
template.

Using Control Panel Templates
To use a control panel template, select the 
control panel where you want to add the 
template. Then simply drag and drop the 
template onto the current control panel. This 
will cause the controls within the template to 
be copied to the control panel.
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Reassigning IR commands on multiple controls 

When a template is added to a control panel, the control assignments of those controls will be the 
same as when the control panel template was created. SQD provides a simple way of reassigning 
multiple controls quickly and easily. 

This can be useful when:

- The user has changed devices (like swapped out a TV).

- The user is creating a new setup for a different user / customer who has different equipment or 
the equipment is controlled through a different 
blaster.

To reassign multiple commands select multiple 
button controls and then right click on one of the 
selected controls, and the screen as shown on the 
right will appear.

Simply select the device (within the current 
configuration) that the selected controls should work 
with, and SQD will attempt to move all the 
assignments to the newly selected device. 

SQD will attempt to convert all commands 1:1 to the new device. The assignment to the correct 
blaster will occur automatically. If a control does not map 1:1,  SQD will set the command to 
undefined … which will allow the user to identify unassigned commands that could not be 
converted. 

To ensure that commands can be converted in this way, it is important to use the standard SQ 
command names when learning new commands so that SQ Remote can smoothly transfer 
between devices.

Deleting Control Panel Templates
To delete a control panel template, simply select the template in the list of control panel templates 
that you want to delete, and then right click on it. A popUp menu option will appear to allow you to 
delete the selected template.
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Control Pad Templates
SQD also allows the user to create templates of complete control pads in the same way as for 
control panels.

Creating new ControlPad Templates
To create a new control pad template, select the control pad that you want to use, then either - 

- right click on the control pad in the control pad and panels tree, to bring up the popUp menu, or

- select Create Control Pad Template from the “Templates” menu. 

This will bring up the name entry screen for the 
control pad template. 

After the “Accept” button has been pressed a template will 
be added to the control pad templates list.

Using Control Pad Templates
To add a control pad template to the current configuration, select the template within the control 
pad template list, and drag the selected template across the screen and drop it into the Control 
Pad and Panel tree on the left hand side of the screen.
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Once a control pad template has been dragged to the current configuration it can then be edited 
and any required control assignments can be carried out.

Deleting Control Pad Templates
To delete a control pad template, simply select the template in the list of control pad templates that 
you want to delete, and then right click on it. A popUp menu option will appear to allow you to 
delete the selected template.
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Managing Your SQ Blaster Devices
SQD allows you to manage your SQ Blaster devices, add new ones to your configuration and to 
build a library of devices. Note: SQD will not automatically detect and install SQ Blaster devices, 
but they can be added manually of the device ID is known or if the IP address is known.

The SQ Blaster Management screen is shown below. This is accessed by tapping on the SQ 
Blasters Tab:

Blasters that are already held within the configuration will be shown in the list on the right. 

Testing a Blaster: Selecting a blaster within the list will cause SQD to query the selected device 
for status. This will be shown in the status area in the center of the screen. 

Changing a Blasters Name: To change the name of a blaster within the configuration that is being 
edited select the blaster within the list and then edit the name of the blaster in the text field at the 
top center of the screen under “Blaster Config Settings”. Commit any changes that you make by 
pressing the ‘Update” button.

Changing the Blaster Timeout Value: To set the period that SQ Remote will wait before declaring 
a blaster unit “unreachable”, change the value in the timeout box. Commit any changes that you 
make by pressing the ‘Update” button.

Enable / Disable a Blaster: Blasters may be kept within a configuration but “disabled”. Blasters 
that are disabled will no longer be shown as connected or disconnected. Commit any changes that 
you make by pressing the ‘Update” button.

Add New Blaster: New blasters can be added to the current configuration by entering a name and 
the IP address of a blaster unit (or its ID followed by “.local” - example “sq-blaster-3771.local”). 
Note that the .local name convention will only work if you have Bonjour installed on your computer 
(available free from Apple for the PC).  Pressing the “Add” button will create a new blaster unit 
within the configuration. If the IP address is unknown - a “pseudo” blaster can still be added to 
enable a configuration to be completed. Devices can then be “moved” to a real blaster at a later 
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time. You must add at least one blaster to the configuration to be able to add AV devices (and thus 
IR code sets).

Blaster Library
SQD allows the user to create a library of blaster systems. 
This is mainly for installer use, where the ability to add 
customer blasters to new configurations can be useful.

Blaster devices can be added and deleted to and from the 
library and added to the library from the current 
configuration.  Simply select the blasters within the list to 
add or copy, and then select the correct action: Add, Delete 
etc.. 
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Managing AV Devices
SQD allows you to manage your AV devices for your current configuration as well as create your 
own libraries of often used devices. This also includes creating your own devices (code sets), 
importing, exporting and direct testing. SQD also includes the full double IR database that is used 
within SQ Remote. 

Selecting a Device within the Current Configuration
To see which AV devices are associated with each blaster in your configuration, select a baster in 
the list on the right. If you need to add blaster units - you can do so in the blaster page. See the 
previous section of this manual for more information. 

Once a blaster is selected its “devices” are shown in the center list.  You can add devices, delete 
devices and move devices between blasters. 

Deleting Devices
To delete a device, select it and press the delete button. You can select multiple devices to delete if 
you wish. If you select to delete a device that you have not saved to your Device Library, SQD will 
ask you to confirm your decision to delete. 

Moving Devices between Blaster Units
Select the device that you wish to move, then select in the Edit Selected Blaster area, select the 
blaster you want to move the device to from the drop down list. Once you have selected the correct 
blaster, simply press the “Update Device”  button and the device will be reassigned.

Editing Devices
If you want to edit the meta-data of a device, select it then edit the data in the Edit Selected Blaster 
area of the AV Devices screen.  Press the “Update Device” button to commit your changes. if you 
change the name of a device that you already added to your Device Library, and then try to add it 
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to your library again, SQD will create a new copy of your device within the Library - it will not 
overwrite the existing device. If you try and save the same device to the library twice, SQD will ask 
if you want to create a new copy.

Creating and using a Device Library
As already mentioned SQD allows you to create libraries of the most common devices that you use 
to create configurations. This is intended to assist installers that install the same kinds of 
equipment, and makes device selection simple and easy.  

It also allows the installer to create their own personal 
library of devices with their own code sets etc. To add 
devices to the library, select the devices you want to add, 
and then press the “Add Device(s) to library button. 

To open the library, press the “Open Device Library”

Once the separate Library window is opened you can 
select and add devices to the current configuration. 

When you add devices to a configuration you must select 
the blaster that you are adding the devices to.

Adding Empty (New Devices)
To add new (empty shell devices) to the currently selected blaster simply press the “Add New 
(Empty) Device” button. This adds a new device to the blaster that has no IR commands and no 
meta data. You will need to add the meta data yourself. IR commands can be then learned or 
imported from external files (see the section on Managing IR Command Sets)
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Add Devices to a Blaster From the IR Database
To add new devices from the SQ Database, select the blaster that you want to add a device to, 
then press the “Add Device From IR Database” button. This will open the IR Database window 
(see screen shot below).  The process for selecting a code set is:

(1) Select the brand, (2) Select the device Type, (3) Select the Code Set, (4) Select the Blaster that 
you want to add the code set to.

If the selected blaster is available (on your network) you will be able to test any of the codes by 
selecting it in the code set list, then pressing the “Test Selected Code” window. You can choose 
between “Press and Hold” or “Macro mode” (macro mode = fixed number of repeats ). Once you 
are happy that the code set you have selected is the one that you need, press the “Add Device” 
button. 

You may select several devices, one after another before closing the Add Device window.

Once you have added code sets as described above, these code sets (as devices) will be 
available to you within your configuration for assigning to controls within your control pads. 
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Managing IR Command Sets
SQD gives you the ability to manage the individual code sets for your devices. Select the device 
that you want to manage in the devices list within the AV Devices screen. Remember to select the 
correct blaster first. Then press the “Manage IR Commands” button.

Within this area of SQD you can:

- Test IR Commands,
- Change command Names
- Learn Codes
- Enter (paste) Pronto Hex codes
- Add New Commands
- Import and Export command sets

Testing IR Commands
Select the command that you wish to test, and press the Test button = if the blaster that this code 
set (device) is associated with is on your local network, the text on the test button will turn green. 
You can test the code in both “Press and Hold” mode and in “Macro Mode” (macro mode = fixed 
number of repeats).

Changing Command Names
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Simply edit the command name within the text field for the selected command and then press the 
“Update Command” button. 

Learning IR Codes
Select the command that you want to learn (overwrite) or create a new command (see note above 
on standard names. Then press the learn code button, you will be guided through the process of 
learning a command with on screen prompts. The process of learning is essentially the same as 
within SQ Remote. Once you have learned a new code and are happy with it you can press the 
“Update Command” button to commit the code to the selected command.

Entering a Pronto Hex Code
Select the command that you want to add the code for from within the existing code set, or create 
(add) a new command. Then cut and paste the pronto hex code into the code window at the 
bottom right hand side of the screen. You can then test this code immediately with the test button. 
if you are happy with the code, you can commit this with the “Update Command” button.

Importing Code Sets
To import sets of IR codes SQD gives you two options. You may either :

1) Import a standard SQ XML format file (as is created 
when you export a command set). This option is 
most useful when sharing code sets between users 
of SQ Remote

2) Import a code set from a csv (comma separated 
value) file. This is most useful if you have an 
existing code set in pronto hex format that you want 
to import. 

The format for this file is: {command name}, {IR 
Command Data}. Each line should only contain two 
elements separated by a “comma”. The first line 
should not contain titles. 

Select the method of import them use the file browser 
that opens to select the file that you wish to import. 
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Exporting Code Sets
SQD gives you 2 options to export IR Codes:

1) Export in the native SQ XML format. This exports 
an xml file that can be shared between users that 
carries all additional metadata (such as which 
command settings are used  -eg: press & hold vs 
macro mode).

2) CSVExport: This exports the current code set in a 
csv file format. This allows you to export codes to 
be used in 3rd party applications that use the SQ 
Blaster.

  

Note on code export:

The codes held within the SQ Remote database have been encrypted for use with the SQ Blaster. 
They will not work with other systems. The SQ Blaster will however recognize and accept imported 
pronto hex codes. This export mechanism is provided for users to obtain the maximum utility with 
the SQ Blaster system and to promote the exchange of learned code sets between users. Abuse of 
this functionality with the intent to extract the codes within the SQ Database for decryption 
purposes will be pursued with legal action to the fullest extent. 

Adding New Commands
If you add new commands to a device, you will need to 
name the commands. The fields in the upper left hand 
corner of the screen allow you to change the name of 
any selected command (new or existing). 

To change the name of a selected command (select 
the command from the command list  - these are listed 
in the larger (longer) list below the name section on the 
left hand side of this screen.

The name of the selected command will appear in the 
name box. Simply edit this name and click update 
name to change the name of the selected command.

Standard Command Names
The small list box below the name entry field shows the square connect standard command 
names. You can select a name from this list by clicking on it. Using standard names is 
recommended, as this will allow the auto - assignment of command codes to the control panel 
templates within SQ Remote. SQ Remote cannot auto assign non-standard command names. 
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Macros Screen
SQD gives you full macro editing capabilities - allowing you to edit and test macros, both at the 
individual step stage and the full macro level. 

Note: SQD does not yet have the ability to fire scene commands to MiOS systems. These steps 
are “skipped” during a macro test.

The Macro screen, allows you to:

- Add new macros, 

- Save macros to a library (for installers that create macros for standardized equipment).

- Import macros from the library

- Delete existing macros

- Export macros (one or multiple) to a native SQ XML file format for transfer between users.

- Import macros XML files 

- Add and edit individual macro steps - ir commands, pauses between commands, and to fire other 
macros. Scenes cannot be added at this time, but if they are present within an imported macro or 
the current configuration (imported via box.net from an iOS device) then the scene data will be 
maintained.
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- Test the individual IR steps

- Test complete macros

 Command List Screen
The command list screen allows users to manage their command lists. In particular it is intended to 
allow users to import / export and exchange lists of channels.

The command list screen allows users to:

- Add new lists

- Edit list names

- Save command lists to a local library for reuse in different configurations

- Import and Export Lists to native SQ XML files.

- Import of Lists from csv (coma separated value) files. This is to allow users to import files 
containing lists of channels that have been created in text editing software or excel.

- Add and edit new list items: Channels, Macros, Scenes, and append lists to other lists.  

- Add icons to lists (drag and drop icons into the lists).
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Note: To use icons you will need export your icons to box.net then import them into your SQ 
Remote (HD or Lite). Importing of icon images is done within the Command List setup area within 
SQ Remote.

Icons are saved within your box.net account in a folder named SQImages. If this folder is not 
present in your account, SQ Designer will create it for you when you upload icon images for the 
first time. 

URLs Screen
The URL screen allows user to manage their list of URLs that they create / add to the SQ Remote 
application. URLs that are named and entered here can be tested directly. Note that url views 
within SQD may not appear the same as those within an iOS device as often web developers will 
tailor the content and layout of a web page for a specific device. 

The URL screen allows users to:

- Add new URLs to their configuration

- Delete URL’s

- Rename URL’s 

- Test URL’s

- Add URL’s to a local library for reuse in other configurations
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- Add URL’s to the current configuration from the library

Themes
The themes page provides the user with a simple drag and drop process for creating themes.

Themes are packages of image files and a descriptor xml file that are contained within a zip 
archive file. These zip files can be installed (loaded) into SQ Designer from the local hard drive or 
directly from box.net. SQ Designer also allows you to export themes directly to box.net or as a 
local zip file so that your themes can be shared with other users (should you so wish).

Theme files are loaded and exported through the “File” menu.

The theme area shows a list of list of available themes that have been installed within SQ 
Designer.  Themes are not “loaded” at runtime for editing, as there are many image files that need 
to be loaded. If you wish to edit a theme, or make a copy of an existing theme to extend it, you 
must select it from the themes list on the themes screen within SQ Remote.  

Note: It is not necessary to load a theme within the theme area of SQ Designer to use it within the 
editor screen. 

To use an installed theme within SQ Designer in the editing 
area, simply select the theme from the drop down box on the 
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Editing Screen:

Once a theme has been selected the editor will display the theme backgrounds and control images 
using the selected theme. Below is an example of a screen being edited for an iPad display using 
an early theme.

Editing and Creating New Themes
SQ Designer provides the tools to make theme creation relatively simple. You can either start from 
a new theme, or copy (or edit) an existing theme. 

Start by either clicking the “Add New Theme” button in the SQ Designer theme area, or select an 
existing theme from the list of installed themes. Note - you can download themes from your box.net  
file (if you have any installed there), or select one from the available themes on the Square 
Connect website. (coming soon). If you wish - you may submit your own themes to Square 
Connect to be included on the website for other users to download.

Once you have selected a theme, SQ Designer will load it. This mat take several seconds so 
please  be patient.

Once the theme has loaded the themes screen will reveal several new sections that will allow you 
to drag and drop new images into the theme template to create your theme.

Below: Screen shot of theme screen after loading of a theme - showing the main background 
images of a theme.
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If you hover the mouse over each image, a tool tip will display the (internal) name of the image file 
as well as its required dimensions. To change an image within the selected theme, simply drag 
your new images from its location on your local drive onto the image you want to replace. SQ 
Designer will take the image that you drop and replace the original image with it.

Screen shot of the button images within a scene:
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Screen shot showing the icons within a theme:

Additional Theme Images:
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You will need to commit any changes you make to theme images by pressing the ‘Save Changes” 
button. When you do this your changes will be finalized. Changes cannot be undone (unless you 
have the original image that you can drag back), so please make sure that you are working with a 
copy of the original theme if you are not starting with a new theme from scratch.

More information about themes can be obtained in the Square Connect document: SQ Remote 
Themes, a PDF document that can be downloaded from the themes page on the Square Connect 
website (http://www.squareconnect.com/themes.html).

Naming your Theme
You should name your theme with a unique name (as SQ Designer requires unique theme names). 
You can also enter your name and website URL, so that you can receive all the well earned 
“kudos” for any themes that you create and share. The name that you enter into the name box 
within SQ Designer is the name that will be shown within SQ Remote when it is installed/imported.

Theme Name Box.

Sharing your theme
Themes can be exported to your local hard drive or loaded to box.net for installation into SQ 
Remote on your iOS device.  When you export a theme in this way you can name the exported file 
as you like (it will need a.zip extension), but the name that is displayed when it is loaded within SQ 
Designer or SQ Remote will remain the name that is entered in the theme name box within the 
theme area.

Box.net themes folder
To work with box.net with themes, both within SQ Designer and SQ Remote you will need to create 
a themes folder within your box.net account. This folder must be in the root directory of your 
account and be names “SQThemes”. If this folder is missing from your box.net account it will be 
created the first time that you save a theme to box.net.

 

Using themes within SQ Remote
Themes are only available with the SQ Remote HD and SQ REmote Lite. The original version of 
SQ Remote does not allow access to themes. To use a theme within SQ Remote HD or Lite you 
will need to install (download) the required theme from box.net to your iOS device, and then select 
it within the control panel editing area to make it active. 

Themes from other users as well as official themes from box.net are will become available on the 
themes page of the Square Connect web site. (http://www.squareconnect.com/themes.html)
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Connecting to MiOS Home Automation Systems
To be able to assign home automation controls to devices connected to your MiOS home control 
systems, and for SQ Designer to show the names of devices and scenes within home automation 
controls, you need to connect SQ Designer to your MiOS system(s).

Note: SQ Designer does not store any information about your MiOS systems, so you need to 
connect each time you use it if you want to have access to this functionality. You can enter your 
myMiOS user credentials in preferences and specify that SQ Designer connect at launch to your 
system(s). This can prolong the initial launch for SQ Designer but removes the need to do this at 
each launch manually.

Installers: If you are editing or creating control interfaces for remote clients you can obtain the 
MiOS system information remotely in this way by having your clients give you guest or full access 
to their systems.

The MiOS Connection Screen:

The MiOS connection screen gives the user several options:

- Discover / Refresh MiOS System Data. Clicking this button will cause SQ Designer to search 
for MiOS systems. If you do not provide any myMiOS service data SQ Designer will only be able 
to discover MiOS Systems that are on the local network.
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- Purge MiOS Data. Clicking this button will cause SQ Designer to purge all MiOS system and 
device information that it is currently holding. If you want to swap between myMiOS accounts (if 
you an an installer) then you will need to purge the MiOS data before fetching the data from the 
new account.

-  Use MyMiOS Service. By selecting this option you can force SQ Designer to connect with the 
myMiOS servers to discover MiOS systems. The alternative is to use Manual.

- Manual Settings. If you do not have a myMiOS account, or prefer to connect to the local system 
directly you can select this option and then enter the MiOS system IP address as well as its 
system ID. The System ID is required for SQ Designer to assign controls to MiOS systems.

- Ignore local systems. If you are working with remote systems and do not want the system to 
load local data, you can select this option. SQ Designer will then ignore any systems that it finds 
on the local network.

MiOS Devices.

Scenes discovered on your MiOS system are displayed in the following way:

xxxxx: location: Name: ID

 - xxxxx is the ID of the MiOS system

 - location is the “room” specified within the MiOS system for this device

 - name is the name given to the device by the user

 - ID is the unique device ID that is set by the MiOS system for the device in question.

Example:

10865: Outdoor: Driveway Light: 17

MiOS Scenes.

Devices discovered on your MiOS system are displayed in the following way:

xxxxx:  Name: ID

 - xxxxx is the ID of the MiOS system

 - name is the name given to the scene by the user

 - ID is the unique scene ID that is set by the MiOS system for the scene in question.

example:

10633: Porch Light Off: 4
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Preferences
Preferences are accessed through the Edit > Preferences menu. 

General
The General area allows the user to define how 
they would like the editor screen to start up, and 
whether SQ Designer should start in full screen 
mode.

MiOS (Vera) Settings
This area allows you to enter your myMiOS 
settings so that you can automate the 
connection to your MiOS systems on startup of 
SQ Designer.
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Additional Settings
Set auto save on/off and the time interval for 
auto-saves so that you don’t loose your work 
should the unexpected happen.

Set the option to check for updates of the 
software and updates of the user manual on 
startup of SQ Designer.
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